
 

SIMATIC

WinCC
Readme WinCC Comfort/Advanced 
V13

System Manual

Online help printout

 
02/2014
 

General notes
 1

 

STEP 7 Basic
 2

 

WinCC Comfort/Advanced
 3



Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

indicates that minor personal injury can result if proper precautions are not taken.
 

 
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Postfach 48 48
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General notes 1
The information in this readme file supersedes statements made in other documents.

Read the following notes carefully because they include important information for installation 
and use. Read these notes prior to installation.

Notes on the information system
The following function is already described in the information system, but is not available in 
TIA Portal V13:

● Hardware comparison of devices

Functions for S7-1200 as of firmware version V4
In the information system for the TIA Portal V13, functions are documented for S7-1200 as of 
firmware version V4 which are not yet available in the software.

The 64-bit data types will be available for an S7-1200 as of firmware version V4.

User-defined documentation
On the product DVD under "Documents\UserDocumentation", you will find instructions for 
creating and using user-defined documentation.

Display of interfaces via online access
If the Ethernet interfaces for online access are not displayed sporadically, install hotfix 
KB2588507 (for Microsoft Windows) from the Microsoft Support website.

Internet link: http://support.microsoft.com/kb/2588507 (http://support.microsoft.com/kb/
2588507/en-us)

Display of Asian characters in the TIA Portal
If the Chinese TIA Portal is installed on a different Asian Windows operating system (for 
example Korean) and texts are not displayed correctly in the TIA Portal, select English as the 
"Language for non-Unicode programs" in the Windows Control Panel.

Instruction "GET_NAME: Read out name of a module"
According to the online help, the read name depends on the IO device type. 

For an HMI Panel, however, it is not the name of the station that is output – as described in 
the online help – but the name of the interface module.
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Online operation in hibernate mode
We recommend that you do not use the two options "Hibernate" and "Sleep" in online operation; 
if you do, communication problems could occur. If necessary, adapt the computer's energy 
options.

Installing new .Net versions or .Net service packs
● Close the TIA Portal before installing a new .Net version or a new .Net service pack on your 

programming device/PC.

● Restart the TIA Portal only after successful installation of the new .Net version or the 
new .Net service pack.

Notes on handling
● If a project in the list of projects last used is located on a network drive that is not connected, 

you may experience delays when opening the "Project" menu.

● When you insert a CPU, you may need to wait for some time if the project editor is open at 
the same time. This generally takes longer when you insert the first CPU in a newly created 
project. To be able to continue working more quickly, you should close the project editor 
before inserting a CPU.

● The alarm "Application is not responding" may appear in Windows 7 with functions that 
take a long time to run (loading the CPU for example). If this occurs, wait until the function 
has correctly finished.

● If you have installed a Microsoft mouse with IntelliPoint, you may find that it superimposes 
components over the buttons of the title bar. If this is the case, uninstall the IntelliPoint 
software from Microsoft.

● Enabling the "Virtual Desktop" options with NVIDIA graphics cards can cause problems. In 
this case, disable the "nView virtual desktop manager" of your NVIDIA graphics driver.

Using the TIA Portal via a remote desktop
In principle, it is possible to use the TIA Portal via a remote desktop connection. During 
configuration, you should, however, avoid disconnecting the connection to the desktop client. 
In rare cases, this can lead to the software user interface being blocked.

If you experience this blockage, follow these steps on the desktop client.

1. Open the Windows Task-Manager and close the "rdpclip.exe" process.

2. Type in "rdpclip.exe" in the command prompt to restart the process.

Note that the current content of the clipboard will be lost. You can, however, then continue 
configuration as usual. To be on the safe side, you should restart the TIA Portal at the next 
opportunity.

General notes
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Notes on SIMATIC memory cards
The SIMATIC memory cards have been formatted and set up by Siemens for use with S7-1200 
and S7-1500 modules. This format must not be overwritten; otherwise, the card will no longer 
be accepted by the modules. Formatting with Windows tools is therefore not permitted.

Behavior in case of open force job
Note that an active force job is retained even after you have loaded a new project to the 
SIMATIC memory card. This means you should first delete the active force job before you 
remove a SIMATIC memory card from the CPU and before you overwrite the card in the PC 
with a new project. If you use a SIMATIC memory card with unknown content, you should 
format the SIMATIC memory card before the next download.

Subnet addressing for CP 1613 and CP 1623 
CP 1613 and CP 1623 are communication modules with microprocessor. To ensure secure 
management of communication links, these are processed on the module. The protocol stack 
in your PC is used for diagnostic purposes (SNMP, DCP). To allow both protocol stacks (i.e. 
CP 1613/23 Firmware and CP 1613/23 NDIS access) access to the same partners, is 
recommended to place both stacks of a module in the same subnet.

Editing a device IP address
Do not use the address range from 192.168.x.241 to 192.168.x.250 when editing a device IP 
address. If necessary, this address range is automatically assigned by the system to a 
programming device. Depending on the subnet mask, this applies also for all network classes.

Migrating projects with the TIA Portal
After the migration of hardware configurations and program blocks from earlier automation 
solutions, first check the functionality of the migrated project before you use it in productive 
operation.

Working with automatically synchronized network drives
Automatic synchronization after a network interruption can result in current (local) project data 
being stored as a "backup" on the network drive through user interactions. This could cause 
outdated project data to be loaded from the network drive when opening the project. For this 
reason, we do not recommend that you store TIA Portal projects on synchronized network 
drives. 

If, however, you do work on synchronized drives, you can continue working locally in the event 
of a network interruption. In this case, you must always ensure that the TIA Portal application 
is closed while data is synchronized. The synchronization itself must be implemented in such 
a way that the current (local) project data replaces the project data on the network drive. 

General notes
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Entry of decimal places
With certain Windows language settings, it may occur that the entry of values with a comma 
as decimal place is not recognized (entering "1,23" leads to an error). Instead, use the 
international format ("1.23").

Access protection for memory cards in USB card readers
By improving the security mechanisms for online access and engineering of S7-1500 CPUs, 
the data storage on memory cards has been changed. For this reason, this version of STEP 
7 cannot evaluate the passwords of the configured protection level when reading project data 
from memory cards that is accessed via a USB card reader. The changed behavior affects the 
memory cards for CPUs of the S7-1200/1500 series. Therefore, use physical safeguards to 
protect critical project data on memory cards for these devices.

 

 Note

This restriction is not related to online access to devices or the know-how protection of 
program blocks.

 

Information on the TIA Portal in online support
Overview of the most important technical information and solutions for the TIA Portal in the 
Siemens Industry online support.

Internet link: TIA Portal in Siemens Industry online support (www.siemens.com/industry/
onlinesupport/tiaportal)

All information on service and support in the Siemens Industry online support:

Internet link: Service and support in Siemens Industry online support (http://
support.automation.siemens.com)

Here, you can also subscribe to the newsletter that provides you with latest information relating 
to your products.

Starting the TIA Portal
When you start the TIA Portal, Windows attempts to update the Certificate Revocation List 
(CRL) of "windowsupdate.com".

If no Internet access is available and there are multiple DNS servers, a timeout may occur and 
delay the start of the TIA Portal.

Compatibility with V12 SP1
An empty V12 SP1 project with the name "TIA_Portal_Project_V12.0.1.3.ap12" is installed in 
the installation directory under ..\Portal V13\SampleProjects to allow TIA Portal V13 to be 
opened in compatibility mode V12 SP1. This project must be copied to a local directory with 
full access before it can be used. For more information on this, refer to FAQ ID 835846.

General notes
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FAQs on the TIA Portal
FAQs on the TIA Portal are available at FAQs (http://support.automation.siemens.com/WW/
view/en/28919804/133000). 

General notes
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STEP 7 Basic 2
2.1 Security information

Upgrades and updates
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should also 
be considered. For more information about industrial security, visit

http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit

http://support.automation.siemens.com (http://support.automation.siemens.com/WW/
llisapi.dll?aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002)

Network settings
The following tables show the network settings of each product you need to analyze the 
network security and to configure external firewalls:

STEP 7 Basic
Name Port number Transport 

protocol
Direction Function Description

ALM 4410* TCP Inbound/
outbound

License 
service

This service provides the complete 
functionality for software licenses and is 
used by both the Automation License 
Manager as well as all license-related 
software products.

RFC 1006 102 TCP Outbound S7 
communicatio
n

Communication to the S7 controller via 
Ethernet/PROFINET for programming and 
diagnostic purposes.

DCP --- Ethernet Outbound PROFINET The DCP protocol (Discovery and Basic 
Configuration Protocol) is used by 
PROFINET and provides the basic 
functionality for locating and configuring 
PROFINET devices.
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STEP 7 Basic
SNMP 161 UDP Outbound PROFINET The SNMP client functionality is used by 

STEP 7 to read status information from 
PROFINET devices.

* Default port that can be changed by user configuration

 

WinCC ES Basic (without simulation)
Name Port number Transport 

protocol
Direction Function Description

ALM 4410* TCP Inbound/
outbound

License 
service

This service provides the complete 
functionality for software licenses and is 
used by both the Automation License 
Manager as well as all license-related 
software products.

HMI Load 1033 TCP Outbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

* Default port that can be changed by user configuration

 

Simulation RT Basic
Name Port number Transport 

protocol
Direction Function Description

HMI Load 1033 TCP Inbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

Ethernet/
IP
 

44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

2222 UDP Inbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Modbus 
TCP

502 TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

RFC 1006 102 TCP Outbound S7 channel Communication to the S7 controller via 
Ethernet/PROFINET

Mitsubishi 
MC

5002 TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for 
connections to Mitsubishi PLCs.

2.2 News

News in the TIA Portal
To keep you up-to-date with the latest news, Siemens Industry Online Support now offers a 
website with the latest news on a variety of topics of the TIA Portal.

All news on STEP 7 Basic are available at a glance at this link:

STEP 7 Basic
2.2 News
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support.automation.siemens.com/WW/view/en/84047138)

2.3 Notes on use

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Online operation
The simultaneous online operation of STEP 7 V5.5 or earlier and STEP 7 Basic V13 has not 
been approved.

Simultaneous online connections on an S7-1200 CPU
It is not possible to establish an online connection from multiple TIA Portal instances 
simultaneously to the same S7-1200 CPU.

Configuring and assigning module parameters
You will find an overview of the modules that can be configured and assigned parameters with 
STEP 7 Basic V13 at http://support.automation.siemens.com (http://
support.automation.siemens.com/WW/view/en/28919804/133000).

Removing/inserting the memory card
After removing or inserting a memory card, always perform a memory reset on the CPU in 
order to restore the CPU to a functional condition.

Removing and inserting Ethernet modules
If Ethernet modules are removed and re-inserted during operation, you must boot the PC; 
otherwise, the "Accessible devices" functionality in STEP 7 or NCM PC will not display all 
devices. While the PC boots, Ethernet modules must be activated.

Comparing project data
The comparison functions (online/offline, offline/offline) currently do not take hardware into 
consideration.

Loading project data with TIA Portal V12 and V13 (S7-1200) 
If you load the project data of an S7-1200 CPU with the TIA Portal V13, you can no longer use 
TIA Portal V12 to access this data. To do this, first restore the factory settings of the CPU. 

STEP 7 Basic
2.3 Notes on use
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Read the additional information on this in the online help under "How to reset a CPU to factory 
settings".

Using project data of distributed IO-Link master modules from TIA Portal V12 in V13
The following procedure applies if you are using distributed IO-Link master modules in TIA 
Portal V12 that are not GSD devices and were configured with PCT: To continue using your 
project data from TIA Portal V12.0 in TIA Portal V13.0, you have to export them in the PCT 
before you upgrade the project. After the upgrade, you must import the project data once again 
using the PCT.

Compatibility
The device configuration and program of an S7-1200 CPU must always be configured with the 
same STEP 7 version. Usually, the TIA Portal makes sure that no version conflicts occur by 
outputting appropriate notifications during loading to the device.

This automatic verification is not possible with S7-1200 CPUs with firmware version V1.x. In 
this case, users themselves must ensure that no version conflicts occur.

2.4 Editing devices and networks

2.4.1 General information on devices and networks

Contents
General information on devices and networks.

S7 PCT IO-Link
The S7 Port Configuration Tool is available for free download at the following link.

http://support.automation.siemens.com/WW/view/37936752 (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&groupid=4000002&extranet=standard&viewreg=WW&n
odeid0=33102519&objaction=csopen)

2.4.2 Use of modules on the S7-1200

Contents
Information that could not be included in the online help and important information about 
product characteristics.

STEP 7 Basic
2.4 Editing devices and networks
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Use of modules on the S7-1200
The modules listed below are not supported on the S7-1200.

Family Module Order number
S7-300 FMs SM 338 6ES7 338-4BC01-0AB0

FM 350-1 6ES7 350-1AH03-0AE0
FM 350-2 6ES7 350-2AH00-0AE0, 6ES7 350-2AH01-0AE0
FM 351 6ES7 351-1AH01-0AE0, 6ES7 351-1AH02-0AE0
FM 352 6ES7 352-1AH02-0AE0
FM 355 S 6ES7 355-1VH10-0AE0
FM 355 C 6ES7 355-0VH10-0AE0
FM 355-2 C 6ES7 355-2CH00-0AE0
FM 355-2 S 6ES7 355-2SH00-0AE0

S7-300 PtP-CP CP 340 6ES7 340-1AH02-0AE0, 6ES7 340-1BH02-0AE0, 6ES7 
340-1CH02-0AE0

CP 341 6ES7 341-1AH01-0AE0, 6ES7 341-1AH02-0AE0, 6ES7 
341-1BH01-0AE0, 6ES7 341-1BH02-0AE0, 6ES7 
341-1CH01-0AE0, 6ES7 341-1CH02-0AE0

Network component Diagnostics repeater 6ES7 972-0AB01-0XA0
ET 200S 1 Count 24 V 6ES7 138-4DA04-0AB0

1 Count 5 V 6ES7 138-4DE02-0AB0
1 Step 5 V 6ES7 138-4DC00-0AB0, 6ES7 138-4DC01-0AB0
2 pulses 6ES7 138-4DD00-0AB0, 6ES7 138-4DD01-0AB0
1 SI 6ES7 138-4DF01-0AB0
1 SI Modbus 6ES7 138-4DF11-0AB0
1 SSI 6ES7 138-4DB02-0AB0, 6ES7 138-4DB03-0AB0
1 Pos Universal 6ES7 138-4DL00-0AB0
SIWAREX 7MH4910-0AA01, 7MH4912-0AA01, 7MH4920-0AA01

ET 200M SIWAREX 7MH4 900-2AA01, 7MH4 900-3AA01, 7MH4 950-1AA01, 
7MH4 950-2AA01

Loading S7-1200 module comments to the PG/PC
In central configurations with S7-1200, comments of modules, submodules and signal boards 
are not loaded. With CPs/CMs, only the comments of the IE interface or DP interface are 
loaded. In distributed configurations with ET 200SP or ET 200MP, only the comment of the 
channels is loaded from the I/O modules.

2.4.3 Replacing ET 200S positioning modules

Contents
Information that could not be included in the online help and important information about 
product characteristics.

STEP 7 Basic
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Replacing ET 200S positioning modules
This information relates to the positioning module "1 Step 5V" (6ES7 138-4DC00-0AB0) from 
a project which was created with TIA Portal V11.0. When replacing these modules from the 
TIA Portal V11.0 with a new version of these modules, the parameter settings are reset to the 
default values.

This is the case with one of the following procedures:

● Replace the positioning module 6ES7 138-4DC00-0AB0 with its successor module 6ES7 
138-4DC01-0AB0 by means of a device exchange.

● Updating the module version using the appropriate button in the device properties in the 
Inspector window.

2.4.4 CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX

Contents
Information that could not be included in the online help and important information about 
product characteristics.

CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX
The module AS-Interface CP 343-2 (order no.: 6GK7 343-2AH01) can be inserted in an 
expansion rack of the SIMATIC S7 Embedded Controller EC31-RTX (order no.: 6ES7 
677-1DDxx-0BB0), but the CP 343-2 cannot be operated with the EC31-RTX.

2.4.5 Notes on online and diagnostics

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Hardware detection followed by online connection
When the "Online > Hardware detection" command is performed for an unspecified CPU, the 
online configuration is not loaded from the CPU. If you do not load the configuration resulting 
from the hardware detection to the CPU, the device and network views will always show a 
difference between the offline and online configurations. It will appear that there are different 
configurations in the online and diagnostic views, although the MLFBs are identical in the actual 
CPU and the offline CPU.

STEP 7 Basic
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2.4.6 Network components

2.5 Programming a PLC

2.5.1 General notes on PLC programming

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Information about network security
For communications access between the TIA Portal and CPU or between HMI (except for HMI 
access using "GET/PUT communication") and CPU, there are integrated security functions. 
The provide greater protection from manipulation and higher access protection. To protect 
against unauthorized network access to a CPU with standardized communications access 
such as "GET/PUT", "TSEND/TRCV", "Modbus", "FETCH/WRITE", you should also take 
suitable additional measures (e.g. cell protection concept).

Renumbering PLC data types
For better performance, the CPUs of the S7-1200 module process PLC data types with 
numbers. The user is not aware of these numbers, because the system processes the numbers 
independently. This means number conflicts are automatically resolved. When using know-
how protected blocks that use PLC data types, it may be useful to set up your own numbering 
system (recommended > 5000) because the automatic resolution of numbering conflicts may 
result in a password prompt (compilation required).

To renumber the default number of a PLC data type, follow these steps:

1. Open the project library in the "Libraries" task card.

2. Drag the compilable PLC data type to the "Types" folder.
The "Add type" dialog opens.

3. Enter the properties of the new type.

4. Click "OK" to confirm.

5. Right-click the PLC data type.
The shortcut menu opens.

6. Select "Edit type" in the shortcut menu.

7. Open the "PLC programming" task card once again.
The extension "in testing" is now added to the name of the PLC data type.

8. Right-click the PLC data type.
The shortcut menu opens.
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9. Select "Properties" in the shortcut menu.

10.Change the number of the PLC data type in the "General" section.

11.Select "Release version" from the shortcut menu of the library.

The PLC data type now has the new number and can be used. The assigned number is retained 
even if the type of the PLC data type is revoked.

Generating external sources from blocks
When generating external sources from blocks, the changes made directly in the block 
interface to the default values of PLC data types are not exported to the sources. This means 
these values are not available when the sources are imported once again. The default values 
are applied instead. To prevent this loss of data for the modified default values, the changes 
must be made directly in the PLC data type and not in the block interface. In this case, the 
changes are also exported when generating external sources.

Indirect indexing of ARRAY components of data type bit string in SCL
In TIA Portal V13, you can address the components of an ARRAY for a CPU of the S7-1200 
series in SCL with a tag of the data type BYTE, WORD or DWORD as index in addition to a 
tag of the integer data type if the IEC check is not set.

Explicit data type conversion in SCL
As of TIA Portal V13, the string is displayed with a leading sign during explicit data type 
conversion of SINT/INT/DINT/LINT_TO_STRING or WSTRING in SCL and transferred aligned 
to the left.

The result is an incompatibility with TIA Portal V12 SP1, in which the string was transferred 
aligned to the right during conversion.

Start value behavior during "Upload from device"
The start values that you have changed with the instruction "WRIT_DBL: Write to data block 
in the load memory" will be lost during execution of the action "Upload from device".

Loading inconsistent programs to a device
In TIA Portal, it is not possible to download inconsistent programs to a device without a 
consistency check. During the loading process, all blocks of the program are implicitly checked 
and are compiled again in the event of inconsistencies. If, however, there are programs on 
your CPU which were loaded with earlier versions of STEP 7, these programs could 
demonstrate inconsistencies. 

In this case, note the following:

If you load an inconsistent program from a device, you will not be able to load the program 
unchanged to the device afterwards, because a consistency check always takes place during 
the loading process and existing inconsistencies are corrected.
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Process image of PTO/PWM outputs
Do not use PTO/PWM outputs in the process image (for example, for access in the user 
program, for online functions or in HMI). The update rate of the process image is much slower 
than the rate of the signal changes. The display in the process image therefore does not reflect 
the signal flow.

Monitoring blocks in LAD and FBD
If the start of the current path is outside the visible range, it may not be possible to determine 
the input value. In this case, the current path is shown grayed out.

Avoid using PLC data types generated by the system in libraries
Some instructions generate their own PLC data types during instancing which are saved in 
the "PLC data types" project folder. However, you should not use these system-generated 
PLC data types in any library, because they may be recreated by the system at any time and 
may result in an unfavorable system behavior. 

Using global data blocks in assignments
It is not possible to assign the contents of a global data block to a structurally identical data 
block, e.g. using a move box.

2.5.2 Instructions

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Notes on the information system
The following function is already described in the information system, but is not available in 
TIA Portal V13:

● "ASI_CTRL" instruction for CPUs of the S7-1200 module

Instruction "TRCV_C: Receive data via Ethernet" 
Contrary to the information provided in the online help, the communication connection is 
terminated immediately, and not after sending data, when the CONT parameter is set to the 
value "0".
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Instruction "T_CONFIG: Configure interface" 
The CPU is restarted after you have executed the "Configure interface" instruction in order to 
change an IP parameter. The CPU goes to STOP mode, a warm restart is carried out and the 
CPU starts up again (RUN mode). Make sure that the control process is in a secure operating 
mode after the CPU has been restarted following execution of the "Configure interface" 
instruction. Uncontrolled operation can result in serious material damage or personal injury 
due to malfunctions or programming errors, for example. Non-retentive data could be lost.

Parameters ERROR and STATUS

ERROR STATUS
(DW#16#..)

ERR_LOC Explanation

0 00000000 0 After the instruction has been 
executed successfully, the 
STATUS parameter 
"00000000" does not return 
any value.

Instruction "GET_DIAG: Read diagnostics information"
MODE 3 at the MODE parameter is not supported by the S7-1200 CPU.

Using instructions with parameters of type VARIANT in code blocks with different access types 
(S7-1200)

Code blocks (FBs/FCs) and data blocks (DBs) can be created with different access types 
("standard" and "optimized"). In code blocks, you can call any instructions. Certain instructions 
(for example, "WRIT_DBL" and "READ_DBL") use pointers of type VARIANT at input and 
output parameters to address data blocks.

Ensure that you do not use these instructions in programs in which code blocks of different 
access types are called reciprocally. This could cause the following to occur:

● A structure from a standard data block is directly or indirectly passed to an optimized code 
block, which forwards this structure directly or indirectly to one of the blocks mentioned 
above.

● The reverse scenario, whereby a structure from an optimized code block is directly or 
indirectly passed to a standard data block, which forwards this structure directly or indirectly 
to one of the blocks mentioned above.
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2.5.3 Testing the user program

2.5.3.1 Testing with the watch table

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Multiple access to the same CPU
Access to a CPU from a PG/PC is permitted only when a TIA Portal is open. Multiple access 
to the same CPU is not permitted and can lead to errors.

Loading data blocks during an active control job
 

 Note

Loading changed data blocks during an active control job can result in unforeseen operating 
states. The control job continues to control the specified address, although the address 
allocation may have changed in the data block. Complete active control jobs before loading 
data blocks.

 

Testing programs converted from STEP 7 V10.5/V11.0
To monitor and test a program converted from STEP 7 V10.5, you have to first compile and 
load with STEP 7 V13.0.

2.5.3.2 Testing with the force table

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Example
If I/O access to the address "IB0:P" takes place in the user program, it is not permitted to force 
the following I/O address areas: I0.0:P, IB0:P, IW0:P and ID0:P.
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2.6 Inter Project Engineering (IPE)

2.6.1 Notes on IPE

Contents
Information that could not be included in the online help and important information about 
product characteristics.

 

Comment box of the device proxy
Contrary to the description in the information system for the TIA Portal V13, with the "Inter 
Project Engineering" functionality, the comment field for a device proxy cannot be edited.

Restricted functionality
In the TIA-Portal V13, the "S7 GRAPH overview" and "PLC code display" functionality cannot 
be used in conjunction with the IPE device proxy. 

2.7 Technological functions

2.7.1 Notes on technological functions
There are no notes about the technology functions.
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WinCC Comfort/Advanced 3
3.1 Security information

Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Any third-party products that may be in use must 
also be taken into account. For more information about industrial security, visit

http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx) 

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit

http://support.automation.siemens.com (http://support.automation.siemens.com)

Passwords
Various passwords are set by default in WinCC. For security reasons, you should change 
these passwords.

● On HMI devices with version V11 or V12, the password "100" is preset for the Sm@rtServer 
and for the integrated Web server. A default password is not preset for HMI devices with 
version V13.

● For the user "Administrator", the default password is "administrator".

Integrated Web server
It is always possible on a PC to access HTML pages in Runtime, even though the option"HTML 
pages" is disabled. Setup always installs the standard pages of the Web Server on the PC. 
Assign an administrator password to prevent unauthorized access to the pages.

Communication via Ethernet
In Ethernet-based communication, end users themselves are responsible for the security of 
their data network. The proper functioning of the device cannot be guaranteed in all 
circumstances; targeted attacks, for example, can lead to overload of the device.
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Ending Runtime automatically
If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped on the HMI device. The HMI device then 
switches autonomously to "Transfer" mode. Transfer mode may cause undesired reactions in 
the system.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode. To block access to the transfer settings 
and thus avoid unauthorized changes, assign a password in the Control Panel.

Network settings
The following tables show the network settings of each product which you need in order to 
analyze the network security and for the configuration of external firewalls:

WinCC Advanced (without simulation)
Name Port 

number
Transport 
protocol

Direction Function Description

ALM 4410* TCP Inbound, 
Outbound

License service This service provides the complete 
functionality for software licenses and is used 
by both the Automation License Manager as 
well as all license-related software products.

HMI Load 1033 TCP Outbound HMI Load 
(RT Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

HMI Load 2308 TCP Outbound HMI Load 
(RT Advanced)

This service is used to transmit images and 
configuration data to panels.

* Default port that can be changed by user configuration

 

WinCC Simulation for Basic Panels
Name Port 

number
Transport 
protocol

Direction Function Description

HMI Load 1033 TCP Inbound HMI Load 
(RT Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

EtherNet/IP 44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

2222 UDP Inbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Modbus TCP 502 TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET

Mitsubishi MC 5002 TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for connections 
to Mitsubishi PLCs.
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WinCC Simulation for Panels and Runtime Advanced
Name Port 

number
Transport 
protocol

Direction Function Description

DCP --- Ethernet Outbound PROFINET The DCP protocol (Discovery and basic 
Configuration Protocol) is used by PROFINET 
and provides the basic functionality for locating 
and configuring PROFINET devices.

LLDP --- Ethernet Inbound, 
Outbound

PROFINET The LLDP protocol (Link Layer Discover 
Protocol) is used by PROFINET for topology 
detection.

SMTP 25 TCP Outbound SMTP 
Communication

This service is used by WinCC Runtime 
Advanced to send e-mails.

HTTP 80* TCP Inbound Sm@rtServer The Web server is only available when 
Sm@rtService is activated. The used port may 
differ depending on automatically selected 
settings.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET

NTP 123 UDP Outbound Time 
synchronization

The NTP protocol (Network Time Protocol) is 
used for time synchronization in IP-based 
networks.

SNMP 161 UDP Outbound PROFINET The SNMP client functionality is used by STEP 
7 to read status information from PROFINET 
devices.

HMI Load 2308 TCP Outbound HMI Load
(RT Advanced)

This service is used to transmit images and 
configuration data to panels.

HTTPS 443* TCP Inbound Sm@rtServer The Web server with HTTPS protocol is only 
available when Sm@rtService is activated. 
The used port may differ depending on 
automatically selected settings.

VNC server 5900* TCP Inbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

5800* TCP Inbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

VNC client 5500 TCP Outbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

* Default port that can be changed by user configuration

PROFINET protocols for Panels and Runtime Advanced
Name Port 

number
Transport 
protocol

Direction Function Description

DCP --- Ethernet Outbound Lifelist, 
PROFINET 
Discovery and 
configuration

The DCP protocol (Discovery and basic 
Configuration Protocol) is used by PROFINET 
and provides the basic functionality for locating 
and configuring PROFINET devices.

LLDP --- Ethernet Inbound, 
Outbound

PROFINET Link 
Layer Discovery 
protocol

The LLDP protocol (Link Layer Discover 
Protocol) is used by PROFINET for topology 
detection.
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PROFINET protocols for Panels and Runtime Advanced
MRP --- Ethernet Outbound PROFINET 

medium 
redundancy

The MRP protocol (Medium redundancy 
protocol) enables control of redundant 
transmission paths using a ring topology.

PROFINET IO 
Data

--- Ethernet Inbound, 
Outbound

PROFINET 
Cyclic IO data 
transfer

Cyclic data exchange is used by panels for 
direct keys and LEDs.

NARE --- Ethernet Inbound, 
Outbound

Name Address 
Resolution

This protocol is used to resolve network names 
and assign IP addresses.

PROFINET 
Context 
Manager

34964 UDP Inbound, 
Outbound

PROFINET 
connection less 
RPC

The PROFINET Context Manager provides an 
endpoint mapper in order to establish an 
application relation (PROFINET AR).

 

Communication connections for Panels and WinCC Runtime Advanced
Name Port 

number
Transport 
protocol

Direction Function Description

Telnet 23 TCP Inbound Telnet This service can be used for maintenance.
SMTP ** TCP Outbound SendEMail This service is used by Windows CE / PC 

Runtime to send e-mails.
HTTP 80* TCP Inbound Hypertext 

Transfer 
Protocol

The HTTP protocol is used for communication 
with the internal Web server.

RFC 1006 ** TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET.

HMI Load 102 TCP Inbound Transfer This service is used to transmit images, 
Runtime, and configuration data to the panel 
via PN/IE

NTP ** UDP Outbound Time 
synchronization

The NTP protocol (Network Time Protocol) is 
used for time synchronization in IP-based 
networks.

DCOM*** 135 TCP Inbound OPC server This service is a component of the Microsoft 
Windows operating system. Communication 
via OPC (DA) is based on DCOM. Therefore, 
this service is required to initialize OPC (DA) 
connections.

DCOM*** ** TCP Outbound OPC server The communication via OPC (DA) is based on 
DCOM and uses unspecified ports assigned by 
the system. This should be taken into 
consideration when using OPC (DA) and 
creating rules for the firewall.

NetBIOS over 
TCP/IP

** UDP Outbound With the use of 
Remote File 
Share

Register / log on to a remote server.

NetBIOS over 
TCP/IP

** UDP Outbound With the use of 
Remote File 
Share

Register / log on to a remote server.

SNMP 161 UDP Inbound Simple Network 
Management 
Protocol

The SNMP client functionality is used by STEP 
7 to read status information from PROFINET 
devices.
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Communication connections for Panels and WinCC Runtime Advanced
HTTPS 443* TCP Inbound Secure 

Hypertext 
Transfer 
Protocol

The HTTP protocol is used for communication 
with the panel-internal Web server via Secure 
Socket Layer (SSL).

Modbus TCP ** TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

Mitsubishi MC ** TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for connections 
to Mitsubishi PLCs.

Printing ** TCP Outbound Printing Printing on the control panel (via Ethernet).
HMI Load 2308 TCP Inbound Transfer This service is used to transmit images and 

configuration data to panels. On Comfort 
Panels, this service is replaced by 
DeviceManager and SCS in V13 and higher. 
This service is used to transmit configuration 
data to WinCC Runtime Advanced.

HMI Load 50523 TCP Inbound Transfer This port is used if port 2308 is not available.
This service is used to transmit images and 
configuration data to panels. On Comfort 
Panels, this service is replaced by 
DeviceManager and SCS in V13 and higher.
This service is used to transmit configuration 
data to WinCC Runtime Advanced. 

ALM 4410* TCP Inbound, 
Outbound

Application 
License 
Manager

This service of RT Advanced makes available 
the complete functionalities for software 
licenses and is used by the Automation 
License Manager.

OPC UA 4870* TCP Inbound OPC UA server This service is required for communication via 
OPC UA.

HMI Load 5001 TCP Inbound Device Manager This service is used to transmit images and 
Runtime to panels.

HMI Load 5002 TCP Inbound SCS (System 
Configuration 
Server)

This service is used to transmit configuration 
data to panels.

VNC client 5500 TCP Inbound Sm@rtServer Reverse VNC server connection. Receive 
mode is set for the VNC client.

VNC server 5800* TCP Inbound Sm@rtServer VNC server connection HTTP
5900* TCP Inbound Sm@rtServer VNC server connection

SIMATIC Logon ** TCP Outbound UMAC (User 
Management to 
the Access 
Control)

Register / log on to a remote server.

Allen Bradley 
Ethernet IP

** TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Reserved 49152 ... 
65535

TCP/UDP Outbound  Dynamic port range is used, for example, to 
connect to the remote file sharing. 

*   Default port that can be changed by user configuration
**  Port is assigned automatically.
*** Supported by WinCC Runtime Advanced only.
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3.2 News

News about the TIA Portal
You can learn about the latest news about various topic areas of the TIA Portal in Siemens 
Industry Online Support.

All news concerning WinCC can be found here: News (http://support.automation.siemens.com/
WW/view/en/88360672)

3.3 Notes on use

Contents
Information that could no longer be included in the online help and important information about 
product features.

Working with standard user rights 
If you are working with standard user rights in Windows 7, "User Account Control (UAC)" must 
not be disabled. The "User Account Control" is enabled in Windows 7 by default.

For more information on the "User Account Control", refer to the online help for Windows 7.

On-screen keyboard
Once you have opened the TIA Portal, you can no longer call the on-screen keyboard.

To call the on-screen keyboard in Windows, use the following command: “Start > All Programs 
> Accessories > Ease of Access > On-screen keyboard”.

Copying HMI devices with HMI connections
If you copy an HMI device with HMI connections to a PLC, the HMI connection in the new HMI 
device is not automatically connected to an existing PLC with the same name. This applies to 
copying within a project as well as copying across projects.     

To access the PLC tag via HMI tag in the new HMI device, you have to complete the 
configuration of the HMI connection immediately after copying. Proceed as follows:

1. Open the "Devices & Networks" editor.

2. Connect the new HMI device to the desired network.

3. Open the connection table.

4. Select the HMI connection of the new HMI device.

5. Select the desired PLC under "Partner".

If you compile the new HMI device or connect additional PLC tags in between copying the HMI 
device and completing the connection, there may be some instances in which an additional 
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HMI connection to the same PLC is created. This is especially true if you connect HMI tags 
with DB array elements.

Device replacement
After an HMI device has been replaced, you should check the appearance of the configured 
screens. Changing the size of the display may result in changes to the position and appearance 
of screen objects, e.g. recipe view and alarm view.

Device replacement - communication
If an HMI device is replaced, error messages of the type "... are not supported in the new 
configuration. and will therefore be removed" may be generated. These alarms refer to 
configured connections of the device and are triggered, for example, if the HMI devices have 
a different number of interfaces. These connections are marked red after a device replacement. 
If you would like to continue to use these connections, you have change the configuration of 
the connection. Proceed as follows:   

1. Open the "Devices and Networks" editor.

2. Click "Network" in the toolbar of the network view.

3. Network the interface of the HMI device with the interface of the CPU.

4. Click in the table area of the network view on the "Connections" table.

5. Select the connection marked red.

6. Enter the new interface under "Properties > General > Interface" in the Inspector window.

Specifying the time of modification in the overview window
The times of modification displayed in the overview window only refer to changes to the object 
itself. Changes to subordinate objects, e.g. screen objects in a screen, do not cause the time 
of the last change to the screen to change in the overview window.   

HMI device wizard
When you create a device with a color display using the HMI device wizard, the graphics of 
the navigation buttons may be displayed in black and white. This error only occurs, however, 
if the new device is created with the same name as a device with a monochrome display which 
has been deleted in the meantime.

You can avoid this error by always deleting the associated graphics in the Graphics collection 
whenever you delete a device from the project.
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Objects with object references in the project library
Two copying methods can be used in WinCC flexible.   

● With "simple copy" a WinCC flexible screen including an IO field, for example is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. With regard to tags, it functions like 
"simple copy" in WinCC flexible. With regard to graphics, graphics lists and text lists, it functions 
like "copy" in WinCC flexible.

If you stored objects with references to tags in a library in WinCC flexible, you must reconfigure 
the referenced objects when using them in WinCC.

Reports with Asian character sets on Windows CE devices
If Asian characters sets are displayed in an illegible manner in a report on a Windows CE 
device, you must change the character sets for the objects in the report. it is sufficient to change 
to a different character set and then reset the original character set.

Installation sequence for Startdrive
When you install Startdrive on a PC, adhere to the following installation sequence:

● Install STEP 7 V13.0.

● Install Startdrive.

Compatibility with V12
An empty V12.0.1.3 project with the name "TIA_Portal_Project_V12.0.1.3.ap12" is installed in 
the installation directory under ..\Portal V13\SampleProjects to allow TIA Portal V13 to be 
opened in compatibility mode V12. This project must be copied to a local directory with full 
access before it can be used. For more information on this, refer to FAQ ID 66027369.

File browser on a Windows 8 PC with touch screen
You can only operate the file browser dialog with a mouse, keyboard or on-screen keyboard 
(without using the touch function) on a Windows 8 PC with touch screen. We recommend using 
the file browser dialog of the Windows operating system with the help of a script on a touch 
screen PC with Windows 8.
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3.4 Migration

Contents
Information that could no longer be included in the online help and important information about 
product features.

Project languages in WinCC
WinCC V13 does not support all project languages that were available in WinCC flexible, such 
as Arabic. If you receive an empty project as the result of your migration, you may want to 
check the set editing language. Do not set the project languages that are not supported as 
editing language in the source project. Proceed as follows:

1. Open the project with WinCC flexible.

2. Change the editing language to English, for example.

3. Save the project.

4. Restart the migration.

Migrating an integrated project with ProTool objects
The "PROTOOL option package(s) missing in STEP 7" error message output during migration 
of a WinCC flexible project that is integrated in STEP 7 indicates that WinCC flexible 2008 
SP3 is installed on your system. Moreover, the project still contains objects that were 
configured using ProTool. Do not open the project with WinCC flexible 2008 SP3! Proceed as 
follows to migrate the project:

1. Copy the project to a computer on which WinCC flexible 2008 SP2 and STEP 7 are installed.

2. Open the project in the SIMATIC Manager.

3. Remove all ProTool objects from the project.

4. Execute the "Save as" command in the "File" menu.

5. Enable the option "With reorganization" in the "Save project as" dialog.

6. Click OK.

7. Copy the project back to the original computer.

8. Restart the migration.

Migrating a WinCC V7 project: Border line of rectangles
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1" 
and "Draw insider border = yes".

You then migrate the WinCC V7 project to WinCC V13.  To have the rectangle displayed 
correctly, follow these steps. 
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1. Open the Inspector window of the rectangle.

2. Open the property list.

3. Disable "Widen border line inwards".

Progress bar
As long as the progress bar still shows a value of 100%, the software is still busy running 
remaining tasks such as the closing of references. The software will not respond to user input 
while this status is given.

Open a project created with WinCC V11
When you open a V11 project with a WinCC V13 version, it is no longer be possible to open 
this project with an older version afterwards.

Managing third-party ActiveX controls
The migration also supports third-party ActiveX controls. However, the controls must be 
registered in the operating system. If an ActiveX control is not registered, migration is canceled.

If you save a project with the migration tool and perform the migration yourself on another PC, 
the controls must also be registered on this PC.

Migrating integrated projects with alarm views 
An alarm view is enabled with all alarm classes in an integrated project. The alarm classes are 
disabled during migration of the project.
Once the migration of the project is completed, check the settings in the alarm view. 
Enable the require alarm classes in the Inspector window of the alarm view if needed under 
"Properties > General".

Migrating more extensive projects from WinCC V7
We recommend the use of a 64-bit operating system for the migration of more extensive 
projects from WinCC V7.

Migrating projects from WinCC V7
In TIA Portal V13, you can continue to use projects from WinCC V7.2 after migration. Projects 
from earlier WinCC versions cannot be migrated directly to WinCC TIA Portal version V13. If 
you wish to continue using such projects in TIA Portal V13, you must first migrate them to the 
WinCC V7.2 Classic page. To do so, use WinCC V7.2 with the latest update.

Migration log
As of TIA Portal V13.0 alarms are sorted into a tree structure in the migration log. This means 
all alarms that are part of a specific subsystem are stored in one folder. The result is an increase 
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in the number of folders in the tree structure. Press the shortcut <NUM+ X> to expand the 
currently selected folder and all subfolders in one single step.

 

Restrictions for user-specific project data
1. Folders and files you have created in the WinCC V7.2 project directory are not copied to 

the new project directory during the migration. You must adapt all scripts that access such 
directories and files after the migration.

2. C standard functions of WinCC V7 are not migrated. If you have made changes to the C 
standard functions in the WinCC V7 project, you must apply these changes manually to 
the TIA Portal after the migration.

Migration of texts in Spanish (international sorting) and Spanish (traditional sorting)
If the WinCC V7 project includes texts in Spanish (traditional sorting), these texts are migrated 
as Spanish (Spain) in WinCC V13. 

If the WinCC V7 project includes texts in Spanish (international sorting), these texts are 
migrated as Spanish (Spain) in WinCC V13.

If the WinCC V7 project includes texts in Spanish (international sorting) as well as Spanish 
(traditional sorting), only the texts from Spanish (traditional sorting) are migrated as Spanish 
(Spain) in WinCC V13. The texts from Spanish (international sorting) are not taken into 
consideration.

See also
Object support during migration
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3.5 Engineering System

3.5.1 Screens and Screen Objects

Contents
Information that could no longer be included in the online help and important information about 
product features.

Display objects after HMI device replacement
If you upgrade a device to the new HMI device versions, you should check the screens 
contained in the project. Because of the new appearance and improved operability, texts of 
symbolic I/O fields may not be completely legible and may be concealed by operator controls. 

Copying display objects between two projects or two devices
In Project_1 configure an alarm window in the Global Screen, for example. You copy the alarm 
window and paste it in the Global Screen in Project_2.             

The enabled alarm classes are partly not enabled in the alarm window after pasting.

This behavior applies to the following display objects:

● Alarm window

● Alarm indicator

● Alarm view

Display of the cross-references in the Inspector window
The Inspector window displays objects used by a screen object in the "About > Cross-
reference" tab.

A screen is open and an object selected. You are using an HMI tag at the object as process 
tag.

The object and the linked HMI tag are displayed in the cross-references. All locations of use 
of the object and the HMI tags are listed.

If the HMI tag is interconnected with a PLC tag or a DB tag, the locations of use of the 
interconnected PLC tag or DB tag are displayed.     

Event names in case of alarms in the "Info" tab of the Inspector window
In some alarms of the Inspector window the event names in the "Info" tab will deviate from the 
names in the "Properties" tab.       
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Name in the "Properties" tab of the Inspector 
window

Name in the "Info" tab of the Inspector window

Cleared ClearScreen
Loaded GenerateScreen
Enable Activate
Change Change
When a dialog is opened ONMODALBEGIN
When a dialog is closed ONMODALEND
User change PASSWORD
Screen change SCREEN
Disable Deactivate
Press Press
Outgoing Going
Incoming Coming
Limit "high limit error" violated AboveUpperLimit
Limit "low limit error" violated BelowLowerLimit
Click Click
Loop-in alarm LoopInAlarm
Release Release
Alarm buffer overflow OVERFLOW
Acknowledge Acknowledgement
Runtime stop Shutdown
Press key KeyDown
Release key KeyUp
Toggle ON SwitchOn
Toggle OFF SwitchOff
Value change Change value

Faceplates
Faceplates cannot be rotated or mirrored.

Tab sequence in screens with faceplates
If you have configured a tab sequence in screens with faceplates in WinCC V12 or WinCC 
V12 SP1, you should check the tab sequence of these screens in WinCC V13. The tab 
sequence may have been changed in both the screen and the faceplate.

Tag prefix of a screen window in WinCC Runtime Professional
The objects of the "Controls" palette do not support the tag prefix that can be configured for a 
screen window.
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I/O field with "decimal" display format and format pattern without "s" prefix
You have linked a process tag to an I/O field. The I/O field is assigned the "decimal" display 
format.     

You may select a signed or an unsigned display format.

A "Format pattern" setting without "s", e.g., "999" has the following effects:

1. You cannot set negative values using the I/O field in Runtime.

2. If the tag assumes a negative value, the I/O field generates a two's complement and a 
corrupted positive value is output.

Trend view on Basic Panels
The trend view buttons are not displayed on Basic Panels. You can operate the trend view 
using the function keys of the HMI device that are assigned corresponding system functions.

Grouping of screen objects
When you group screen objects in WinCC, performance problems can arise in WinCC in the 
case of large nesting depths.

ActiveX and .NET controls
ActiveX and .NET controls are always positioned in the foreground in runtime. 

The configuration of ActiveX and .NET controls on levels is not supported.

Use of bitmaps as icons
In Windows 8 and Windows 8.1, the use of bitmaps with a size of 48x48 pixels and a color 
depth of 32 bits as icons is not supported. 

Border line of rectangles
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1" 
and "Draw insider border = yes".

You then migrate the WinCC V7 project to WinCC V12.  To have the rectangle displayed 
correctly, follow these steps. 

1. Open the Inspector window of the rectangle.

2. Open the property list.

3. Disable "Widen border line inwards".

Border line of “Graphic I/O field" object
In WinCC V13, the dynamization of the border line of the "Graphic I/O field" object in "Two 
states" mode has no effect during runtime.

WinCC Comfort/Advanced
3.5 Engineering System

Readme WinCC Comfort/Advanced V13
36 System Manual, 02/2014



Dynamization of instances of a faceplate type in a group
You are using the instance of a faceplate type in an object group. The properties of the instance 
are also displayed as properties of the group. Any dynamization with tags, scripts or animations 
of the group is not displayed in Runtime.

Preview in screen window
You use your own designs with shadows for screen objects. The screen objects can be 
displayed in a screen window.
The shadows of the screen objects are not displayed in the preview of the screen window. The 
response occurs only in the engineering system. It is displayed correctly in Runtime.

Assigning graphics to a softkey
A graphic can only be assigned to a softkey if the bottom edge of the permanent window does 
not conceal the area of the softkey graphic.

Renaming a PLC in Runtime
If a PLC is connected to the PLC code display in WinCC Professional and Runtime is running, 
changing the name of the PLC during runtime will trigger a error. Do not change the PLC name, 
the IP address, or other properties of the HMI connection during runtime.

Panels and RT Advanced with device version V13: many visually different screen objects 
The use of screen objects with very many visually different properties (e.g., very many different 
styles) can reduce the performance of the user interface in Runtime and can increase the 
amount of available memory space used. Avoid using, for example, very many different corner 
radii: 0 pixel, 1 pixel, 2 pixels, 3 pixels, etc. 

The use of many differently sized “Gauge” objects can have the same effect. Avoid “Gauge” 
of height 48 pixels, 49 pixels, 51 pixels, etc. Instead, use sizes such as 50 pixels, 70 pixels, 
100 pixels.

Dynamization of grouped objects
For groupings with multiple nestings (group in group, faceplate in group, group in faceplate, 
etc.), only the events of the outermost group and the innermost objects can be used for 
dynamization with system functions. System functions that are configured at events of the 
lower-level group or lower-level faceplate are not executed.

Number of characters in text fields, lists and alarm texts
The number of available characters in the text of a screen object is dynamic and depends on 
the HMI device and the memory format. Control instructions and formatting are taken into 
consideration when entering text data and the maximum number of characters is reduced 
accordingly.
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Transparency in WinCC V13
Transparent screens can be displayed without any problems in Runtime. This is true for all 
Comfort Panels and WinCC Runtime Advanced with version 13.0.0.0.
To use the transparency in a graphic view or in a graphic I/O field, the "Fill pattern" property 
must be set to "Transparent" and the property "Use transparent color" must be disabled.

If the property "Use transparent color" is enabled in a device with version 13.0.0.0, the 
transparency of the screen is lost and the transparent screen areas are displayed in black. We 
recommend that you check the "Use transparent color" property at the points of use of 
transparent screens after upgrading existing projects to device version 13.0.0.0. If the screens 
are not displayed correctly, disable this property.

3.5.2 Tags and connections

Contents
Information that could no longer be included in the online help and important information about 
product features.

Display of deleted array elements at location of use of HMI tags
The locations of use of HMI tags, such as the process value of IO fields, are usually indicated 
by the tag name. If the element of an array tag is used, then the tag name will be extended by 
the index of the array element indicated in brackets.

If a used tag is no longer included in the project, then the tag name will still be displayed at the 
location of use. The field will be displayed with a red background to indicate the missing tag. 
If a used array element or the array tag is no longer present, then only the index of the array 
element will be displayed in brackets. The tag name will not be displayed. The field is 
highlighted in red. You can no longer identify the name of the associated array tag based on 
the location of use in this instance.

If you do not know which array tag was linked to this location of use, then it may be necessary 
to link the array element once again.

If a tag or array tag was created based on a reference, then the selected reference will be 
closed automatically.

If an HMI tag is connected with an array element of a PLC tag and the PLC tag does no longer 
exist in the project, then the same behavior will take place in the "HMI tags" editor.       

Array tags as list entry of multiplex tags
You can use the array tags of the Char data type just like the tags of the String data type.       

The use of an array tag of the Char data type as list entry of a multiplex tag in the "HMI 
tags" editor is not supported. 
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Multiplexing tags on a Basic Panel
If you multiplex a tag with an external tag on a Basic Panel, the address is read from the PLC 
in runtime during the first read cycle. The value of the address read is not available until the 
second read cycle.

Runtime Advanced and Panels: Importing array elements and structure elements
Array tags and structure tags are always imported in full with all elements. The elements of 
the array tags and structure tags are not filled further during import.

A new tag is created if the name of a tag corresponds to the name of an array or structure 
element in the import file.

Example:

The import file contains an array tag called "Otto" with 10 array elements. The array elements 
are then called Otto[1], Otto[2], for example.

If the import file contains a tag named "Otto[1]", the first element of the array tag will not be 
filled. Instead, a new tag will be created in the engineering system.

Local ID of HMI connections
You cannot edit the "Local ID" value in the HMI connection properties. You need the local ID, 
for example, for communication by way of AR_SEND. To enable usage of the "Local ID" for 
communication, proceed as follows:

1. Open the network view in the "Devices & Networks" editor.

2. Click "Connections".

3. Select an S7 connection.

4. Select the "Add new connection" command in the shortcut menu of the PLC.

5. Click on the interface.

6. Specify the "Local ID (hex)".

7. Click "Add" and then "Close".

8. Select "Properties > General" from the partner area of the Inspector window and enter the 
IP address of the HMI device for the new connection.

9. Configure the necessary raw data tags for communication in the HMI device.

Tags with the DTL data type
Tags that use the "DTL" data type element by element, can only be used as read-only.

Tag names in faceplates
Use of the "." or "@" character in names of tags in faceplate types is not permitted. Do not use 
these special characters in the tag names in faceplates. 
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RT Professional: Tags with symbolic addressing and "Char Array" data type
Tags with symbolic addressing and the "Char Array" data type are not released for 
communication of RT Professional and SIMATIC S7-1200 V3.

Array elements in WinCC
If you have connected an HMI tag with an array from a STEP 7 data block which does not start 
with a low limit of 0, the array elements are mapped in WinCC to the low limit of 0.

To ensure that you do not have to rethink between the STEP 7 indices and the WinCC indices 
when accessing the individual array elements, the low limits of arrays should also start at 0 in 
STEP 7.

3.5.3 Alarm system and alarm displays

Contents
Information that could not be included in the online help and important information about 
product properties.

Displaying special characters in alarm texts
When configuring alarm texts, a fixed character set is used in the Engineering System. This 
character set allows you to use numerous special characters in alarm texts.     

Language-dependent fonts are used in runtime to display the texts, for example MS PGothic, 
SimSun. The fonts used in runtime do not support all special characters. As a result, some 
special characters are not displayed in runtime.

Use of multiplex tags in output boxes with alarm texts
It is also possible to use multiplex tags in the output boxes of alarm texts in the engineering 
system. During runtime, this leads to an incorrect display of the alarm, because the use of 
multiplex tags is not supported by the basic panels.     

Parameters in user alarms
Contrary to the information in the online help, it is not possible to configure parameters for user 
alarms.
The menu command "Properties > Properties > Alarm parameters" is not available in the 
Inspector window.

Tags in alarm texts of RT Advanced
Tags of data type WChar or WString cannot be displayed in the alarm view in RT Advanced.
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3.5.4 System functions and scripts

Contents
Information that could no longer be included in the online help and important information about 
product features.

Runtime error on startup on TP 277 and OP 277
At the start of the runtime on a TP 277 or OP 277, the error "Global unknown error with VBScript: 
'Expected statement' in script ..." can be reported.

This error is triggered on devices with the Windows CE 3.0 operating system by user functions 
of the following type:

 
Sub VBFunction_1()
With HmiRuntime.Screens("Screen_1").ScreenItems("Button_1")
    .backcolor = vbred
    .visible = not .visible
End With
End Sub

If the error occurs, you need to re-program the user function as follows:

 
Sub VBFunction_1()
    HmiRuntime.Screens("Screen_1").ScreenItems("Button_1").backcolor = vbred
    HmiRuntime.Screens("Screen_1").ScreenItems("Button_1").visible = not .visible
End Sub

Hiding warnings for scripts
Enable "Runtime settings > General > Settings > Also start with faulty scripts". 

As a result, Runtime is started irrespective of faulty scripts. In addition, script warnings will not 
be displayed during a complete compilation

Graphics in faceplates
You have added a graphic view in a faceplate and defined the "Graphic" property as the 
interface of the faceplate. The "Graphic" property can be made dynamic using the interface of 
the faceplate instance.
Use the following notation to address the graphic property via a script: "..\\..\\Graphic name".

Scripts for service projects
Since no interactive user is usually logged in service projects, C scripts and VB scripts lead to 
problems in the following cases:
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● When the scripts require interaction, for example, operator input.

● When the scripts show message boxes.

There is no common data area for C scripting in service mode. Thus, for example, no global 
C variables can be exchanged between the "Scheduled tasks" and "Screens".

Find and Replace in local scripts in WinCC Professional
Use the "Find and Replace" function to find and replace texts within editors. It is not possible 
to use Find and Replace in local scripts.

System functions in local scripts
System functions can be converted into local C scripts or VB scripts. 

If a WString type tag is used in a SetTag system function that was converted into a C script, 
an error message is generated in the Global Script diagnostics window when the function is 
executed. The message does not affect the execution of the function.

This concerns the following SetTag functions:

● SetTagWithOperatorEvent

● SetTagIndirect

● SetTagByTagIndirect

● SetTagIndirectByTagIndirect

● SetTagByProperty

● SetTagIndirectByProperty

Properties no longer used in Comfort Panels and RT Advanced
In WinCC V13, many new visual properties have been introduced and many existing properties 
have been harmonized. 

In the course of revision of the object properties, some properties that could be used in VB 
scripts in earlier versions of WinCC are no longer supported for use in WinCC V13. Scripts 
that use properties that are no longer supported remain valid, but the relevant calls within the 
scripts have no function. These limitations pertain exclusively to Comfort Panels and RT 
Advanced in device version V13.0.

The following table shows the properties of screen objects that are no longer being used: 

 

Property Screen object
BorderBrightColor3D Slider
BorderColor Text field, I/O field, symbolic I/O field, 

date/time field
BorderInnerWidth3D Slider
BorderOuterWidth3D Slider
BorderShadeColor3D Slider
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Property Screen object
BorderStyle3D Text field, I/O field, button, symbolic I/O field, graphic I/O field, 

date/time field, bar, switch
BorderWidth Text field, symbolic I/O field
CenterColor Gauge
DialColor Gauge
EdgeStyle Text field, I/O field

System function "ChangeConnection"
Contrary to the description in the online help, the system function "ChangeConnection" is 
released for the following devices:

● SIMATIC S7-300/400 

● SIMATIC S7-NC

● SIMOTION

The system function "ChangeConnection" is not released for SIMATIC S7-1200.

3.5.5 Reports

Contents
Information that could not be included in the online help and important information about 
product features.

Displaying controls in protocols
A project with WinCC V11 SP2 with Update 4 or earlier is upgraded to WinCC V13.

In this process, it may happen that archive data is not displayed in controls for protocols.

The following controls are affected:

● f(t) trend view

● f(x) trend view

● Table view

Remedial measures for f(t) trend view and f(x) trend view

1. In the control, select "Properties > Properties > General > Display > Online". 

2. Recompile your project.

3. Load the project onto your HMI device.

Remedial measures for Table view:
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1. In the control, select "Properties > Properties > General > Upon opening screen > Start 
update". 

2. Recompile your project.

3. Load the project onto your HMI device.

3.5.6 Recipes

Contents
Information that could not be included in the online help and important information about 
product features.

Arrays in recipe elements
If you have configured both an array as well as the elements of this array for recipe elements 
of a recipe, the loading of data records aborts with the following error message: "290055: Import 
of data records aborted with error"

Use either the array or just the array elements for recipe elements of a single recipe.

3.5.7 User administration

Contents
Information that could not be included in the online help and important information about 
product features.

3.5.8 Communication

Contents
Information that could no longer be included in the online help and important information about 
product features.

Connection interruptions with Mitsubishi PLCs
After multiple connection interruptions, a situation may arise where all the connection 
resources of the Mitsubishi PLC are in use and the connection can no longer be established. 
It is recommended to check these connection resources in the PLC program of the PLC and 
also to enable them again.   
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Limited number of possible HMI connections
An error message is displayed during compilation of a device indicating that the configuration 
of the HMI connection in the "Devices & Networks" editor is invalid. The reason may be that 
the maximum number of possible connections of the HMI device or PLC has been exceeded.

Check the maximum number of available connections. Consult the device manuals of the 
devices you are using.

Communication by means of routing with S7 300/400
Communication of connection partners in different subnets is possible via routing with the 
following connections: PROFINET, PROFIBUS, MPI.

Use of PROFINET IO with panel HMI devices
When using PROFINET IO to connect the direct keys and LEDs of HMI devices to the PLC, 
you can define an offset for the address area of the inputs and outputs during configuration in 
HW Config.

The following restriction applies when a PROFINET IO-capable S7-400 CPU is used with one 
of the HMI devices listed below:

The offset for the start of the address area of the inputs must not be greater than the offset for 
the start of the address area of the outputs.

The restriction applies to the following HMI devices:

● OP 177B

● OP 277

● Mobile Panel 177

For the configuration of the address parameters, open the PLC with the S7-400 CPU in HW 
Config. Select the HMI device connected via PROFINET IO in the station window of HW Config. 
A table with the properties of the HMI device is displayed at the bottom of the station window 
in the detail view. Select the line containing the addresses of the HMI device in the table and 
open the object properties using the shortcut menu.

Enable the "Addresses" tab in the "Object properties" dialog. Configure the offset for the inputs 
under "Inputs > Start". Configure the offset for the outputs under "Outputs > Start".

Exceeding value ranges with Mitsubishi MC and Mitsubishi FX
With some data types, the Mitsubishi MC and Mitsubishi FX communication drivers do not 
check whether the value of a recipe tag exceeds the value range of the PLC tags. The data 
types affected are:

● 4-bit block

● 12-bit block

● 20-bit block

● 24-bit block

● 28-bit block

WinCC Comfort/Advanced
3.5 Engineering System

Readme WinCC Comfort/Advanced V13
System Manual, 02/2014 45



Coordination area pointer in an OPC connection
In principle, the coordination area pointer can be used eight times in an OPC connection. If 
you have configured an OPC connection and you automatically create another OPC 
connection using "Add", the coordination area pointer is only displayed once in the newly 
created connection. In this case, you should change the communication driver of the 
connection. If you then set OPC again as the communication driver, the coordination area 
pointer can again be used eight times.

RT Advanced communication via Station Manager (SIMATIC NET) with an S7-1200
For communication of a SIMATIC S7-1200 with a PC with WinCC RT Advanced via a router, 
the following restrictions apply to the PC:

● Windows 7: Only with installed SIMATIC NET 8.1

● Windows XP: Communication via Station Manager (SIMATIC NET) is not supported

These restrictions also apply if you are using WinAC MP or Station Manager. Connections with 
the help of the Station Manager of Runtime Advanced are always treated as routed 
connections.

Communication between S7-1200 and a multi panel
Communication between an S7-1200 and a multi panel with the "WinAC MP" option installed 
via ProSave is not possible. The HMI devices affected are:

● SIMATIC MP 177 6" Touch

● SIMATIC MP 277 8" Touch

● SIMATIC MP 277 8" Key

● SIMATIC MP 277 10" Touch

● SIMATIC MP 277 10" Key

● SIMATIC MP 377 12" Touch

● SIMATIC MP 377 12" Key

● SIMATIC MP 377 15" Touch

● SIMATIC MP 377 19" Touch

HMI connections in WinCC V13
HMI connections to SIMATIC S7-1200 PLCs with firmware versions earlier than V2.0 are not 
possible in WinCC V13.

Connections via PROFIBUS DP
When a connection between a PLC and an HMI device via PROFIBUS DP is interrupted and 
then re-established, sporadically all other PROFIBUS DP connections in the communication 
network are interrupted and re-established.

De-energize the disconnected station before reconnecting it.
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"Set the IP suite (address) of the PLC in the Control Panel" with SIMATIC S7-1200 V1
The function "Set the IP suite (address) of the PLC in the Control Panel" has not been approved 
for the following PLCs:

● SIMATIC S7-1200 V1

Switching a connection
A connection may be interrupted when it is switched from an HMI device to a SIMATIC 
S7-300/400, to a SIMATIC S7-1500 or to a SIMATIC S7-1200 PLC.

Note the following settings in the SIMATIC S7-1500 or SIMATIC S7-1200 controllers: 

● Absolute addressing of tags

● The "Disable PUT-GET communication" option must be selected

● The "Complete protection" protection level may not be set

RT Advanced in the Station Manager
If RT Advanced and WinAC RTX use the same communication processor of a PC, HMI 
communication with SIMATIC S7-1200 and SIMATIC S7-1500 is not possible.

Raw data communication in redundant projects
Simatic.NET, Named Connections and various communication blocks, such as BSEND/BRCV, 
for example, can only be used to a limited extent in a redundantly configured PC station 
because the connection parameters for the redundant partner server cannot be configured.

3.6 System-wide functions

Contents
Information that could no longer be included in the online help and important information about 
product features.

Inter Project Engineering: Displaying alarms of system diagnostics 
If you do not enable "PLC alarms" when you create device proxy data, system diagnostic 
alarms are not applied to the device proxy data.

System diagnostic alarms of the device proxy are not displayed after initialization of device 
proxy data without "PLC alarms".
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3.7 Compiling and loading

Contents
Information that could no longer be included in the online help and important information about 
product features.

Compiling and loading
If internal errors or warnings occur during compiling, compile the complete project using the 
command "Compile > Software (rebuild all)" in the shortcut menu of the HMI device.

Before you start productive operation with your project, compile the entire project using the 
"Compile > Software (rebuild all)" command from the shortcut menu of the HMI device.

If you are using HMI tags that are connected to the control tags in your project, compile all 
modified blocks with the command "Compile > Software" in the shortcut menu before you 
compile the HMI device.

Settings for update of operating system
If you select the command "Online > HMI device maintenance > Update operating system" 
from WinCC, you cannot change the settings such as the type of PG/PC interface or baud 
rate. The settings used during the last download are always used.

To make changes to the settings, open the "Extended download" dialog using the "Online > 
Extended download to device" command and change the settings. When you click the "Load" 
button the changed settings are saved.

Alternatively, you can perform an update of the operating system with changed settings with 
ProSave. You start ProSave via the Windows Start menu "Siemens Automation > Options and 
Tools > HMI Tools > SIMATIC ProSave".

Incorrect installation of ProSave
If you receive an error message during installation of ProSave when loading data to a target 
device or maintenance of an HMI device, then you cannot remedy this error using the repair 
function of setup. Remove ProSave via the Control Panel. Then start setup and install the 
"ProSave" component again.     

Checking the address parameters
During compilation of an HMI device in the project tree with the command "Compile > Software" 
in the shortcut menu, the address parameters of the HMI device, such as the IP address, will 
not be checked. If you want to ensure that the address parameters are checked as well, you 
will have to compile the HMI device using the "Compile" button in the "Devices & Networks" 
editor of the toolbar.   

Error message when downloading data to the PLC
A panel and a PLC are connected and communicating with other. 
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If a tag is accessed while downloading data from the panel to the PLC, an error message is 
displayed on the panel.     

Delayed reaction in the "Extended download to device" dialog
If the settings in the "Extended download to device" dialog for "Type of the PG/PC interface" 
and "PG/PC interface" do not match the settings on the HMI device, this can result in the 
application not responding for up to a minute.

     

Extended download with an S7-1200 and a Comfort Panel
An S7-1200 PLC and a Comfort Panel are located in the same physical network as the PG/
PC. You open the "Extended download to device" dialog for the Comfort Panel. 

If you enable the option "Show all accessible devices", it may occur that the application stops 
responding.   

OP77A, OP73, TP177A: Loading projects
When loading a project to an HMI device, it can happen that Runtime is not automatically 
ended, even though "Remote Transfers" is activated in the Panel.

If this happens, stop Runtime and manually set the transfer mode on the HMI device.       

Loading a SIMATIC HMI application to a PC station
The following circumstances can lead to an error message during the first load of a SIMATIC 
PC station:

● A SIMATIC HMI application is configured in a PC station in the project

– WinCC Runtime Advanced

– WinCC Runtime Professional

– WinCC Standby

– or WinCC Client

● The property "S7RTM is installed" is activated.

Before you load a SIMATIC PC station for the first time, select the configured device HMI_RT 
(WinCC...) in the project tree. Open the "Extended download to device" dialog and select the 
appropriate interface and parameter settings. Click "Load".

You then load the PC station as normal.     

Project transfer via USB
If you have connected more than one HMI device via USB to your configuration PC, project 
transfer is only possible to the last connected device.
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Opening project files
When you run "HmiIRTm.exe", a dialog opens asking if you want to open the project file (.fwc). 

The following options are available to you: 

● "Yes": A dialog opens allowing you to select a project file (.fwc).

● "No": The dialog closes.

Tag simulator in WinCC Professional does not start
If the tag simulator does not start in WinCC Professional, it may be because the fm20.dll file 
has not been installed in the system yet. The fm20.dll file cannot be distributed and must be 
installed as part of a Microsoft application:
http://support.microsoft.com (http://support.microsoft.com/default.aspx?scid=kb;EN-US;
224305)

You have the following two options for installing the fm20.dll file:

● Install an application, such as Microsoft Office 97, on the destination system. The 
installation routine also installs the fm20.dll file.

● You can also download and install the Microsoft ActiveX Control Pad free of charge. The 
fm20.dll file is also installed in this case. Additional information on the ActiveX Control Pad 
is available on the Microsoft Developer Network website:
http://msdn.microsoft.com/en-us/library/ms968493.aspx (http://msdn.microsoft.com/en-us/
library/ms968493.aspx)

3.8 Runtime

3.8.1 Notes on operation in Runtime

Contents
Information that could no longer be included in the online help and important information about 
product features.

Focus in Runtime
If you have configured a low-contrast combination of focus color and border color in a V12 
project, the focus may no longer be identifiable after changing the HMI device version in 
Runtime. Change one of the two colors.

Language behavior - Layout of on-screen keyboard
The layout of the on-screen keyboard is not switched when the runtime language changes.     
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Tag values exceed the maximum length     
You enter a character string in a string tag via an I/O field. If the character string exceeds the 
configured number of tags, the character string will be shortened to the configured length.

Empty message texts
Runtime is running with a project. The project is saved on a network drive.

In the event of interruptions to the network drive connection, Runtime may attempt to load 
message texts from the network drive.

In the event of disconnection, the alarm window or the alarm view remains empty.

To avoid this, copy the project to a local drive before the starting the project in Runtime.

Complete download in Service mode
If you need to perform a "complete download" to the OS in Service mode from the engineering 
station, Runtime automatically stops and then starts again. 

The project is then no longer in Service mode.

In this state, the power supply is interrupted and WinCC Runtime no longer starts automatically 
on the OS.

Remedy: 

1. Switch the project manually to Service mode after you have performed the "complete 
download". 

2. Close the project manually.

3. Enable Service mode.

4. Start Runtime again using the surrogate icon in the taskbar.

Slow response from the screen keyboard and SmartServer
The following programs may start and respond very slowly under Windows 7 and Windows 
2008 servers:

● Microsoft OSK screen keyboard and HMI TouchInputPC

● SmartServer: <Ctrl+Alt+Del> shortcut in the logon dialog

The delay is caused by the callback for the Internet certificate validation.

Remedy:

You can find the following files
on the product DVD under:
Support\Windows7\CRL_Check or CD_RT\ Support\Windows7\CRL_Check\:

● DisableCRLCheck_LocalSystem.cmd

● DisableCRLCheck_CurrentUser.cmd
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1. Run the "DisableCRLCheck_LocalSystem.cmd" file with administrator rights. Select the 
command "Run as administrator" from the shortcut menu of the file.

2. Reboot the PC.

If the problem persists, follow these steps:

1. Double-click the file and run the "DisableCRLCheck_CurrentUser.cmd" file with user rights.

2. Reboot the PC.
 

  Note

The callback for the certificate validation is disabled for all users or PCs. To restore the 
original state, perform the following files:
● RestoreDefaults_LocalSystem.cmd
● RestoreDefaults_CurrentUser.cmd

You can find the files in the following directory of the product DVD:
● Support\Windows7\CRL_Check or CD_RT\Support\Windows7\CRL_Check\

 

Starting Runtime
Only WinCC Runtime V13 can be started in TIA Portal V13. WinCC Runtime V11.02, V12 or 
V13 can be simulated in TIA Portal V13. 

3.8.2 Notes on operation of panels in Runtime

Contents
Information that could not be included in the online help and important information about 
product features.

License transfer via S7USB
You always need to run WinCC to transfer a license to a panel via S7USB.

Transferring licenses to a panel on 64-bit operating systems
If you are running a 64-bit operating system and the "Edit > Connect target systems > Connect 
HMI device" menu command is not available in Automation License Manager, open command 
line input and run the following command with administrator rights:

"%WINDIR%\system32\RegSvr32.exe" "%CommonProgramFiles%\siemens\AlmPanelPlugin
\ALMPanelParam.dll"

Using the mouse wheel in Runtime
The use of the mouse wheel in Runtime is not supported on all panels.   
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Basic Panels, OP73, OP77A and TP177A: Displaying texts in runtime 
The default font selected in the "Runtime settings > Languages & font" editor has an effect on 
the display of texts in runtime. 

Text entries may be truncated if you selected an unfavorable font size or style.

This setting possibly has an effect on the following text entries:

● Tooltips

● long alarm text

● text in the dialogs

Basic Panels: Connections to S7-1200 and S7-1500 with Backup/Restore
If you use the "Backup/Restore" function, a maximum of two connections from Basic Panels 
to the controllers are possible at any given time.

● SIMATIC S7-1200

● SIMATIC S7-1500

Basic Panels: Backup on the memory card of the PLC
Create the backup file "A.psb" on the memory card of the PLC. An error, for example a 
connection break, occurs when creating the backup.
This will create a corrupt file on the memory card of the PLC. Such a file has "~$" as prefix. 
Delete the file with the prefix "~$" if you want to save a backup again under the same name 
"A.psb".

Basic Panels: Panel Data Storage and S7-1500F
The "Panel Data Storage" PDS function cannot be used on Basic Panels in conjunction with 
S7-1500F when the password for the protection level "Full access incl. fail-safe" is used.

3.8.3 Notes on operation of Runtime Advanced

Contents
Information that could not be included in the online help and important information about 
product features.

Permission for starting Runtime
On a computer running the 32-bit version of Windows 7, WinCC Runtime Professional or 
WinCC Runtime Advanced can only be started when a user is a member of the automatically 
created group, "Siemens TIA Engineer". 
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.Net-Controls in Runtime
If you have incorporated a .Net Control in your project as "Specific .Net-Control", you have to 
copy the files belonging to these controls to the installation directory of WinCC Runtime, e.g. 
"C:\ProgramFiles\Siemens\Automation\WinCC RT Advanced". Otherwise, the control cannot 
be loaded in Runtime.

3.9 HMI devices

3.9.1 Notes on HMI devices

Contents
Information that could no longer be included in the online help and important information about 
product features.

If the PC goes into standby or hibernate mode while the transfer is in progress, the panel status 
after interruption of the transfer is not defined.

Multi-key operation
Unintentional actions can be triggered by multi-key operation:         

● When you are using a key device, you cannot press more than two function keys at the 
same time.

● When you are using a touch device, a standard PC or a panel PC, you can only press one 
function key or button at the same time.

TS Adapter with Ethernet interface
If an HMI device is connected via Ethernet and a TS adapter, it can not be reset to factory 
settings.   

Simulation of the Basic Panels
Use an output field in an alarm text to output an external tag. The content of the output field 
will always be displayed with "0" during simulation.   

Simulation with real PLC connection
The access point used by the simulation is independent from the settings of the engineering 
system and can only be altered in the Control Panel with the "Setting PG/PC Interface" tool. 
If the PLC connection is terminated right after the start of the simulation with alarm 140001, 
you should check the access point used by the simulation with "Setting PG/PC Interface".
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1. Double-click "Setting PG/PC Interface" in the Control Panel. A dialog opens.

2. Select" "S7ONLINE" in the "Access point of application" field as standard for HMI.

3. Select the interface in the "Interface Parameter Assignment Used" area.

4. Exit the dialog "Setting PG/PC Interface" with OK 

Loading of projects without recipe data records
You are using recipes in a project. You transfer the project to a Basic Panel without recipe 
data records. 

You may encounter inconsistencies if you have altered the structure of the recipe in the 
engineering system and the device already held recipe data records.

Check the consistency of the data records in this case. The device will not issue a note for all 
structural changes.       

Floating point numbers on MP 277, MP 377, TP 177B 4'' and CP4
Only floating point numbers in the range from 10-293 ... 10+307 are displayed correctly on the 
HMI devices MP 277, MP 377, TP 177B 4'' and CP4. If the tag value is outside this range, it 
is displayed as 0.

Mobile Panels V2
If you use Mobile Panels V2 in a project, it is not possible to open the project with WinCC V11 
SP1. This affects projects with the following devices:

● Mobile Panel 277F IWLAN (RFID Tag)

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277 IWLAN V2

"Zone ID/Connection point ID" tag of a Mobile Panel 277 IWLAN V2
The tag used for the "Zone ID/Connection point ID" must be of data type INT for Mobile Panel 
277 IWLAN V2 devices. Adapt this data type if necessary when migrating a project.

HMI devices with operating system Windows CE 5.0 or higher
Owing to a modified client-server communication security setting, the time difference between 
the HMI device (client) and PC (server) must not exceed 1 day. If you back up recipe data from 
the HMI device on a network drive, for example, make sure that the time is set correctly on the 
PC (server) and the HMI device (client).

HMI devices with high communication load
S7 Diagnostics should be enabled if a Panel is assigned many connections to PLCs or other 
HMI devices. Otherwise, you will risk overload on the Panel.
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Device replacement in the engineering system
In the engineering system, you replace a device with configured LED keys with a device without 
LED keys. Runtime start fails after you have transferred the project data to the device. 

For this reason, delete the LED key configuration before you replace the device.

Restrictions for the HMI device, MP 377 15" Touch daylight readable
The following functions are not supported in WinCC V12 for the MP 377 15" Touch daylight 
readable HMI device:

● Option: Sm@rtServer

● System function: SetAndGetBrightness

● Direct keys

Upgrading Basic Panels to WinCC V13
Before you upgrade Basic Panels from version V12 to version V13, transfer the image of the 
V12 SP2 Update 5 or higher to the devices.
In the "SIMATIC ProSave [OS Update]" dialog, select the setting "Reset to factory settings". 

In this way, you always start a functional update of the image.

Affected devices:

● KP300 Basic mono PN 

● KP400 Basic color PN

● KTP400 Basic color PN

Connection switch in the Control Panel with Basic Panels
If you use the "Override protected connection information" function, the following restriction 
applies:

You cannot perform a connection switch in the Control Panel of a Basic Panel from a PLC 
without a protection level to a PLC with a "Complete protection" level.

Mobile Panels 277F 8'' IWLAN
Mobile Panels 277F 8" IWLAN V2 and 277F 8" IWLAN (RFID Tag) cannot be configured with 
WinCC V13.

Basic Panels 2nd Generation
Basic Panel KTP1200 Basic can currently not be configured with WinCC V13. 

The following maximum values are in effect for Basic Panels 2nd Generation.       

 

Alarms
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 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of discrete alarms 1000 1000 1000 1000

 

Screens

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of complex objects per screen  1) This information is not relevant for Basic Panels 2nd Generation.
Number of system diagnostic displays 
per screen

5 5 5 5

Number of array elements per screen 2) 100 100 100 100

1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.

2) Array elements contained in recipes are included in the count.

 

Logs

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of entries per log (including all 
log segments) 1)

10000 10000 10000 10000

Number of log segments 400 400 400 400
Number of tags that can be logged per 
log

10 10 10 10

Cyclic trigger for tag logging 1 s 1 s 1 s 1 s
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